
Specifies that Internet addresses are ignored when Outlook Express checks spelling. 



Specifies the language used when Outlook Express checks spelling.



Click to add or change words in your custom dictionary.



Specifies how you want to send and receive e-mail if you are not connected to the Internet. You can work offline, remain 

disconnected, or try to establish a new connection.



Specifies whether your computer plays a sound when new messages arrive. If you clear this check box, you do not hear any 

sound, but the Outlook Express status bar and message list will display an icon indicating you have unread messages.



Specifies whether to show ToolTips in the message list when an item is cut off by another column.



Displays the list of character sets available.



Click to remove the selected character set.



Specifies whether a message should be marked as read after you have previewed it for the number of seconds indicated. If you 

clear this check box, messages are not marked as read unless you open the message in a message window.To select the 

message in the list, click the Edit menu, and then click Mark as Read.



Specifies whether to send and receive messages in all accounts when Outlook Express is started.



Specifies whether to check your e-mail server for new messages at the specified interval of minutes. It also sends any messages 

in the Outbox at the same time. If you clear this check box, you can only check for new messages by clicking the Tools menu 

and then clicking Send and Receive. 



Specifies whether Outlook Express should permanently delete messages from the Deleted Items folder when you quit Outlook 

Express. If you clear this check box, deleted messages stay in the Deleted Items folder until you open that folder, select the 

messages, and then delete them.



Specifies whether you want to save copies of the messages you send in the Sent Items folder. If you clear this check box, you 

can still save a copy of a message by including yourself on the To, Cc, or Bcc line of the message.



Specifies whether to use Outlook Express whenever you click a link in a Web page to send an e-mail message or choose the 

Mail command in your Web browser.



Specifies whether to automatically resolve any incomplete e-mail addresses while you are composing a message.



Specifies whether to send your messages in HTML format.



Specifies whether to send your messages as plain text, with no formatting.



Click to specify format settings for message encoding, message line length, and reply format.



Click to specify the message encoding format, message reply format, and whether to send pictures with the message. 



Specifies whether to start Outlook Express in the selected newsgroup. If this check box is cleared, Outlook Express starts in the 

newsgroup you were viewing when you last used Outlook Express.



Specifies whether non-English character sets, high ASCII, or double-byte character sets (DBCS) are allowed in the header 

without encoding. If this check box is cleared, these characters will be encoded.



Specifies whether Outlook Express should delete all newsgroup messages from your computer after they have been on your 

computer longer than the specified number of days.



Specifies whether Outlook Express should delete all read newsgroup messages stored on your computer when you quit Outlook 

Express.



Specifies that Outlook Express should compact storage files on your computer when the amount of wasted space exceeds the 

specified percentage.



Click to compact, delete, or remove messages stored on your computer. 



Lists the fonts available on your computer. Click a font, and then see what it looks like in the Sample area. You must select text 

before you can change its font.



Uses a font style to add emphasis to words and phrases in your message. Font formatting applies only to currently selected text.



Changes the size of the selected message text. Font size is relative and depends on the font selected, the size of the base font, 

and the Web browser you are using.



Shows sample text with the selected font formatting. The sample text changes as you change formatting options. 



Click to select a custom color for your text.



Underlines the selected text.



Changes the color of the selected text.



Provides a space for you to type the path and file name of the image. You can also click Browse to locate an image.



Provides a space for you to type the text you want displayed in place of the image when images are turned off or are unavailable 

on the recipient’s computer. The alternate text is also displayed when the image is loading.



Click to specify the image position settings you want to use.



Positions the image on the page depending on your selection.

To do this Select this option

Align the bottom of the image with the baseline of the text. Bottom or Baseline

Align the middle of the image with the baseline of the text. Middle

Align the top of the image with the top of the largest item in a line. Top

Align the image with the left margin, allowing text to wrap around the image. Left

Align the image with the right margin, allowing text to wrap around the image. Right

Align the top of the image with the top of the surrounding text. Texttop

Align the middle of the image with the middle of the line of text. Absmiddle

Align the bottom of the image with the bottom of the line. Absbottom



Places a border around the image in the width (in pixels) you specify. Type a number between 0 and 999.



Adds the specified amount of space (in pixels) to the sides of the image. Type a number between 0 and 999.



Adds the specified amount of space (in pixels) to the top and bottom of the image. Type a number between 0 and 999.



 Specifies whether to create a link to the file you want to send.



Provides a space for you to select a file type and then type the address or path to which you want to create a link. 



Specifies whether to format the paragraph with bullets or numbers.



Specifies the margin to which you want to align the text.



Click to enter more criteria for your search.



Specifies whether to search all the text in any downloaded messages of your e-mail or newsgroup accounts. 



Click to find the next instance of the text you entered.



Enter the text you want to search for.



Click to browse through folders to find the picture file you want.



Specifies whether to log on to your messenger service when Outlook Express starts.



Specifies whether, when you reply to e-mail, the names and e-mail addresses of recipients are added to the Address Book.



Specifies whether the contents of the Inbox are displayed when you first open Outlook Express.



Specifies whether to automatically display e-mail and newsgroup folders that have unread messages.



Specifies whether replies to messages use the format of that message (either plain text or HTML). This setting overrides other 

text formatting settings, such as bold or italic. 



Adds your digital signature to all messages you send. If you sign your messages, recipients will be able to determine if a 

message is really from you. Note: The recipient does not need a digital ID to view signed messages. 



Attempts to encrypt contents and attachments for all outgoing e-mail messages. To send an encrypted message, you must have 

the certificate of the recipient in your Address Book.



Specifies the lowest level of message encryption you are willing to use. Outlook Express will warn you when sending encrypted 

messages with less than this level of encryption.



Click to specify further information about your encryption level, digital signatures, and revocation checking.



For people with modem connections to the Internet, this option specifies that your Internet connection number is not dialed when 

you start Outlook Express. If you select this option, use the Dial button on the toolbar to start an Internet connection.



Specifies which dial-up networking number Outlook Express uses when connecting to the Internet. This option is useful if you 

have more than one dial-up networking connection to the Internet.



Click to change the location of your message store.



Specifies that Outlook Express will compact your messages in the background so that you can continue using Outlook Express.



Specifies that Outlook Express will purge all IMAP messages marked for deletion when you leave the IMAP folder.



Click to change the Internet connection settings. These settings are shared with Internet Explorer.



Specifies that a message appears when you start Outlook Express, prompting you to indicate whether you want to start an 

Internet connection. This option is useful if you frequently read newsgroups or e-mail offline. 



Specifies that if you have more than one dial-up networking connection, Outlook Express displays a message enabling you to 

cancel a connection that isn’t working.



Specifies that Outlook Express disconnect from your Internet connection after you click Send/Recv on the toolbar or download 

newsgroups for offline reading.



Specifies whether messages that have attached picture files (*.bmp, *.gif, or *.jpg) display the picture in the message after the 

message text. 



Specifies whether, in messages that have multiple attached pictures, the pictures are displayed one at a time in the message, 

with forward and backward buttons used to view additional images. 



Specifies the color that you want to highlight any watched messages with.



Click to set the font and text size of incoming messages.



Click to review the list of character-set substitutions that you have previously used for incoming messages. Every time you 

change a character set in a message by using the Language button on the toolbar, you can add it to this list. Then, any incoming 

message with the same character set is automatically reformatted to the character set you specified.



Specifies whether all commands sent to and from the news server are saved in a log file. The log file is useful for 

troubleshooting.



Specifies whether all commands sent to and from the e-mail server are saved in a log file. The log file is useful for 

troubleshooting.



Specifies whether all commands sent to and from an HTTP e-mail server are saved in a log file. The log file is useful for 

troubleshooting



Specifies that commands sent to and from the news server when you download newsgroups for offline reading are saved in a log 

file. The log file is useful for troubleshooting.



Sets the font and size of outgoing message text.



Specifies that the font settings you selected are added to outgoing messages.



Adds the selected image to messages. The image appears behind message text.



Click to select stationery to use for new outgoing messages. 



Click to create a signature or include a business card in outgoing messages.



Specifies whether to add your signature to all outgoing messages. 



Specifies that the text you type is added to the signature. To make this your default signature, click Set as Default.



Adds the file you specify to the end of outgoing messages.



Click to search for files in your local or network folders to append to outgoing messages.



Displays the name of the business card selected to include in new messages. To change business card information, click Edit.



Specifies whether to include your business card in new messages. You can include a different business card for e-mail and news 

messages.



Click to assign different signatures to different accounts. For example, you can assign one signature to your outgoing e-mail 

messages and a different signature to your outgoing news messages.



Click to make the selected signature your default signature for all outgoing messages.



Displays the list of signatures you have created.



Click to rename the selected signature.



Click to remove the selected signature.



Click to create a new signature.



Specifies whether your signature is added when you reply to or forward a message.



Click to create a new Address Book listing to use in your stationery.



Click to change contact information that you want to send as a business card.



Specifies whether to add the contact information for the specified person to outgoing messages. The contact information is in 

vCard file format, which can be read by any digital device.



Provides a space to enter a contact name from your Address Book to use as a business card. The business card is the contact 

information stored in a vCard file, which can be read by any type of digital device. To create an entry for yourself in your Address 

Book, click New. 



Lists the names of the stationery files on your computer.



Specifies whether to show a preview of the selected stationery.



Displays a small sample of the selected stationery.



Click to start Microsoft FrontPage Express and edit the HTML file of the selected stationery.



Click to start Internet Explorer to view more stationery.



Click to search for files to use for stationery in your local or network folders. 



Click to use the Stationery Wizard to create custom stationery.



Specifies whether to indent the original text of a reply or forwarded message with a special character. You can select the 

character you want to use.



Specifies whether to use the selected stationery when sending messages. You can choose different stationery for e-mail and 

news messages.



Displays the name of the selected stationery. To change the stationery, click Select.



Shows a sample of how text will appear with the specified font settings.



Specifies whether to indent the original text of a message when replying to it. If this option is cleared, the entire message is 

aligned on the left.



Specifies whether any pictures in the message (including background images) are added to the message. If this option is 

cleared, only a reference (or pointer) to the picture is included. Use this option if the message recipients do not have access to 

the picture (for example, if it is on your computer or if they are reading the message offline). Including pictures makes the 

message larger and harder to download.



Specifies whether to display a list of icons similar to Microsoft Outlook on the left side of the window.



Specifies whether to display a list of default folders (such as the Inbox, Outbox, and Drafts folders) and folders you create. The 

list appears on the left side of the Outlook Express window.



Specifies whether to display a horizontal bar between the toolbar and the message list that shows the name of the currently 

displayed folder.



Specifies whether to display a list of names from your Address Book. This list appears on the lower left side of the Outlook 

Express window.



Specifies whether to display a horizontal bar along the lower edge of the Outlook Express window that shows the current status 

of the selected folder; for example, how many messages are in the folder.



Specifies that the Outlook Express toolbar is displayed. The toolbar gives you quick access to the most common options.



Specifies whether to display a horizontal bar between the toolbar and the message list that allows you to change which 

messages are displayed. For example, you can choose to hide all messages you have already read. If you create custom views, 

you can select one from this list also.



Specifies whether to display an information window at the bottom of the Outlook Express window. The Info Pane can be resized 

as needed.



Specifies that every time you start Outlook Express, a different tip for efficiently using it is displayed.



Specifies that you want to move the toolbar to a particular area of the Outlook Express window.



Specifies whether to display the name of the toolbar button below the button.



Click to add or remove buttons on the toolbar.



Specifies whether to display the preview pane, which shows the contents of the selected message.



Specifies whether Outlook Express should display the preview pane horizontally (below messages) or vertically (beside 

messages).



Specifies whether to display the information in the To, From, and Subject boxes of the message at the top of the preview pane.



Click to learn more about digital IDs and secure messages.



Click to link to a Web page where you can sign up for a personal digital ID. 



Click to view and manage your personal certificates, as well as certificates from trusted certification authorities and other people 

in your Address Book.



Adds a security label to all digitally signed messages you send. The security label determines who is authorized to have access 

to the message content. 



Click to configure label settings. These settings are used with all messages you send that include a security label.



Click to change the settings for your security zones. 



Lists the names of the policy modules installed on this computer. A policy module defines access rights for messages and grants 

or denies authorization to a message.



Lists the security levels associated with a policy module. Each classification denotes a level of clearance rights.



The privacy mark describes the intent of the classification.



Click to set up the policy module if it requires detailed configuration.



Specifies the encryption algorithm for encrypted e-mail sent to you. This setting is transmitted with each piece of digitally signed 

e-mail you send. Unless you frequently move between machines that support different algorithms, it is not necessary to change 

this setting.



Specifies whether to also encrypt the message to yourself (so that you can read it).



Click to send the digital ID of the message recipient.



Specifies whether your certificate is sent whenever you send digitally signed e-mail. E-mail recipients can use the public key to 

encrypt messages to you.



Specifies that you do not want to check if a digital ID has been revoked.



Specifies that you want to check incoming certificates against a list of revoked certificates to determine if they are current.



Specifies that you want all certificates from the signed messages you receive to be added to your Address Book.



Specifies whether your digitally signed messages should be encoded to help avoid tampering with the signature. If this option is 

on, users of e-mail programs that do not support S/MIME will not be able to read your signed messages.



Specifies whether Outlook Express is used when sending documents from within other applications using the Send command on 

the File menu. Selecting this check box disables both the Microsoft Exchange and Microsoft Outlook e-mail programs for this 

purpose. 



Specifies that Outlook Express attempt to connect to your dial-up Internet e-mail account at the interval you set with the Send 

and receive messages every xx minute(s) option. (To see this option, on the Options menu, click the General tab.)



Specifies whether all commands sent to and from the IMAP e-mail server are saved in a log file. The log file is useful for 

troubleshooting.



Click to change the location of your personal e-mail storage location.



Provides a space for you to enter the name of the file you want to put in your message.



Click to search your computer for the file.



Specifies that the sound file should repeat the number of times you enter.



Specifies that the sound file should repeat continuously.



Provides a space to enter the URL (address) of the Web page you want to use to create your new message.



Provides a space for you to enter the address you want to block.



Specifies whether you want to block e-mail, news messages, or e-mail and news messages from the address you entered.



Shows the list of columns that you can display in the main window. If a column is checked, it will be displayed in the main 

window.



Moves the selected column up one level in the displayed columns.



Moves the selected column down one level in the displayed columns.



Click to display the selected column.



Click to hide the selected column.



Provides a space for you to enter the width of the selected column.



Allows you to enter text to find all IMAP folder names containing the text you entered.



Lists the available IMAP accounts. Click a server to show its list of folders.



Lists the folders available for the selected IMAP account. You can narrow this list to folders that contain a specific word in the 

name or description.



Displays the selected folder in the folder list in the main window. An icon appears next to folders you have chosen to show.



Removes the selected folder from the folder list in the main window.



Downloads the list of folders for the selected IMAP account.



Opens the selected folder.



Lists the available conditions you can apply to this view.



Provides a space for you to enter the name of the view.



Lists the descriptions that apply to the condition you selected. Click any underlined words to complete the description.



Select one or more check boxes to set up criteria that will be applied to incoming messages. For example, if you want this rule to 

apply to messages from a certain person, select the Where the From line contains people check box.



Select one or more check boxes to determine how to handle messages that meet the conditions you set. For example, if you 

want this rule to move messages to a certain folder, select the Move it to the specified folder check box.



Click the underlined areas in the Rule Description box to fill in specific information on the rule conditions. For example, to 

identify the senders this rule applies to, click the words contains people.



Type a descriptive name for your rule to help you remember its contents.



Click to create a new rule for incoming messages.



Click to make changes to the selected rule.



Click to create a copy of the selected rule. This is useful if you want to create a new rule using attributes of an existing rule. 



Click to remove the selected rule.



Click to determine where to apply your rules, for example, to your Inbox or other folders. 



Click to move the selected rule up in the list. Rules are processed in the order in which they appear in the list.



Click to move the selected rule down in the list. Rules are processed in the order in which they appear in the list.



Shows the current contents of your rule. Click any underlined areas to change that part of the rule.



Select individual rules that you want to apply to messages currently in the folder or folders listed below. 



Click to select all the rules listed.



Click to deselect all the rules listed.



Describes the content of your individual rules.



Displays the folder to which your rules are applied.



Click to apply your rules to the subfolders in the currently displayed folder.



Click to find the folder to which you want your rules applied.



Click to apply your rules to the messages in the selected folder.



Click to specify that Outlook Express monitor incoming messages and move suspected junk e-mail to the Junk Mail folder.



Click to specify certain types of messages that should not be treated as junk mail.



Adjusting the slider will affect which messages are filtered as junk mail. Move the slider to the left to catch less junk mail; move 

the slider to the right to catch more. The midpoint is the recommended setting.



Click to set up a schedule for cleaning out your Junk Mail folder. When you select this option, Outlook Express permanently 

deletes all items from your Junk Mail folder at the specified time.



Click to add a sender or domain to your blocked senders list.



Click to modify a selected entry, including whether you want to block this sender from e-mail accounts, news accounts, or both.



Click to remove the selected sender or domain from your blocked senders list. Messages from this sender will no longer be 

blocked if removed.



Select one or more check boxes to set the criteria for your view. Your current view criteria (if any) are already selected.



Displays a description of the view criteria and its associated action. Click an underlined word to switch actions.



Type the name of your view here.



Click to create a new view.



Click to edit the criteria and actions for a selected view.



Click to make a copy of the currently selected view.



Click to remove the currently selected view.



Click to apply a view to the currently selected folder. The view criteria will be applied to messages immediately.



This area displays a description of your view. Click an underlined value to edit the view.



Specifies the character set standard to use for sending international messages.



For Unicode and languages that are written right to left, this check box specifies that all new messages are composed right to 

left.



Uses the English words To, From and Subject in your reply, even if the language of your reply is not English.



Displays all incoming messages using the default encoding regardless of the message headers. Select only if your messages 

are frequently unreadable because the language specified in their headers is inconsistent with the message bodies.



Displays the character set standard used as the default encoding when the check box below is selected.



Specifies whether a request for a read receipt is sent with all outgoing messages. Message recipients can choose whether or not 

to send receipts. If the message recipient agrees to send a read receipt, the receipt will be sent when the message has been 

opened. 



Specifies that Outlook Express will not send a read receipt. 



Specifies that Outlook Express prompt you whenever a read receipt is requested. You can choose whether or not to send a 

receipt when you receive the notice.



Specifies that Outlook Express send a read receipt when one is requested. 



Specifies whether to respond to a read receipt request sent from an individual member of a mailing list. In such cases, the 

requester does not have your e-mail address. Selecting this option protects you from providing your address to unknown 

individuals on the list.



Click to specify options for requesting and sending secure receipts. Only digitally signed messages can contain requests for 

secure receipts. 



Specifies whether a request for a secure receipt is included with all outgoing digitally signed messages. Receipts are sent when 

the message is displayed; however, message recipients can choose whether or not to send receipts.



Specifies that Outlook Express will not send a secure receipt.



Specifies that Outlook Express prompt you before sending a secure receipt. You can choose whether or not to send a receipt 

when you receive the prompt.



Specifies that Outlook Express send a secure receipt when one is requested. 



Specifies whether all outgoing secure return receipts are encrypted, if possible.



Specifies whether secure receipts are checked against the original messages in the Sent Items folder for that account. For IMAP 

accounts, the Sent Items folder is specified in the IMAP account properties. 



Provides a space for you to type another Hotmail address for this person.



Click to add the person whose Hotmail address you typed in Add new to your list of online contacts.



Click to make the e-mail address selected on the left the one used for sending instant messages to this person.



Click to open an instant message window for the e-mail address selected on the left.



Lists the e-mail addresses used for instant messaging. 



Lists the e-mail addresses to which the program is trying to send a message.



Displays the subject of the message that the program is trying to send.



Click to send this message.



Click to stop the program from sending this message.



Click for more information.



A program is trying to send an e-mail message to contacts in your Address Book or contacts list. It is possible that the program 

that is trying to send this message is a virus. Viruses can spread by sending copies of e-mail messages to people listed in your 

Address Book. If you are not sure of the origin of the message that the program is trying to send and do not want the program to 

send the message, click Don’t Send. 



Specifies that you want Outlook Express to warn you when another program tries to send a message to contacts in your Address 

Book or contacts list without your approval. Viruses can spread by sending copies of e-mail messages containing the virus to 

your contacts.



Specifies that you do not want Outlook Express to open or save attachments if they could potentially contain a virus.



Help is available for each item in this group. Click        at the top of the dialog box, and then click the specific item you want 

information about.



Lists the available columns that can be added to your message list.



Lists the columns currently displayed in your message list and the order in which they appear.



Moves the selected column from the Available columns list to the Displayed columns list.



Moves the selected column from the Displayed columns list to the Available columns list.



Moves the selected column up one level in the displayed columns.



Moves the selected column down one level in the displayed columns.



Restores the columns to the settings originally displayed when Outlook Express was first installed.



Lists the available news accounts. Click a news server to show its corresponding newsgroups.



Allows you to enter text to find newsgroup names containing the text you typed.



Lists the newsgroups available on the selected server. You can narrow this list to newsgroups that contain a specific word in the 

name or description. In addition, you can click the tabs to display all of the newsgroups available on the selected server or just 

the subscribed or new newsgroups available.



Specifies whether to search newsgroup descriptions in addition to newsgroup names.



Opens the selected newsgroup.



Adds the selected newsgroup to the newsgroup list in the main window. An icon appears next to a subscribed newsgroup. 



Removes the selected newsgroup from the newsgroup list in the main window.



Downloads the list of newsgroups from the selected news server.



Click a tab to change the listing. Click All to view all newsgroups on the server, click Subscribed to view only those that you 

have subscribed to, or click New to view all newsgroups that have been added since you last connected to the news server.



Lists only the newsgroups that you have subscribed to on the selected server.



Lists the newsgroups that have been added to the server since you last clicked Reset List.



Specifies whether to download the chosen number of messages when viewing a newsgroup or to download all messages in the 

newsgroup.



Specifies whether to display threads and all replies in the message list when you open a newsgroup. If you clear this check box, 

only the original message is displayed.



Specifies whether to mark a message as read after you have previewed it for the number of seconds indicated. If you clear this 

check box, you can still mark individual messages as read. For more information, look up "Marking messages as read or unread" 

in the Help Index.



Specifies whether to check your news server for new messages and send messages from your Outbox at the interval of minutes 

indicated. If you clear this check box, you can still check for new messages and send messages from your Outbox by clicking the 

View menu and then clicking Refresh.



Specifies whether to check for new newsgroups and download their names when you access a newsgroup server. If any are 

found, you can view the list of new newsgroups. If you clear this check box, you can still check for new newsgroups by clicking 

the Tools menu and then clicking Newsgroups.



Specifies whether to mark all messages as read when you exit a newsgroup. If you clear this check box, you can still mark 

individual messages as read. For more information, look up "Marking messages as read or unread" in the Help Index.



Specifies whether to display the body of a message in the preview pane whenever the header is selected in the message list. If 

you clear this check box, you can display the message body by selecting the header and then pressing the SPACEBAR.



Specifies whether to use Outlook Express whenever you click a link on a Web page to go to a newsgroup or when you choose 

the News command in your Web browser. If you clear this check box, your browser will not use Outlook Express, and you must 

install another newsreader to view newsgroups from your browser.



Specifies whether you want to save copies of your newsgroup postings in the Posted Messages folder. If you clear this check 

box, you can still save a copy of a message by including yourself on the Cc line of the message.



Specifies whether to automatically select whole words when selecting text in the body of your message. If you clear this check 

box, you can select text one character at a time, and you can automatically select whole words by double-clicking a word and 

extending the selection word by word.



Specifies whether to include the text of the original message when you reply to a message. You can edit or cut any of the text. If 

you clear this check box, the body of your message contains only the text you type or paste.



Specifies whether to indent the beginning of each line of original text included in your reply, preceded by the character indicated. 

This distinguishes the text you type from the text in the original message. If you clear this check box, then the original text and 

the text you add appear the same.



Click this to select advanced settings for sending messages, specifying message format and line length, and sending messages 

immediately.



Specifies whether a copy of each message you send is saved in the Sent Items folder. If you clear this check box, you can still 

save a copy of an individual message by including yourself on the To, Cc, or Bcc line of the message.



Specifies whether to use Outlook Express whenever you send e-mail replies to the author of a newsgroup message. If you clear 

this check box, your browser will not use Outlook Express, and you must install another e-mail program to send messages.



Click this to select advanced settings for sending messages, including specifying the character set, message format, and line 

length, and for sending messages immediately.



Specifies whether to use a different international character set from the default character set associated with your Regional 

Settings in Control Panel. If you clear this check box, Outlook Express uses the default character set.



Specifies that Outlook Express should encode your messages using MIME. This is the common format used by most Internet 

mail programs. 



Specifies that Outlook Express should encode your messages using Uuencode. This format is commonly used to send binary 

files as attachments in messages posted to newsgroups.



Specifies whether Outlook Express should automatically wrap the text of outgoing messages so that each line is no more than 

the number of characters indicated. Some older Internet mail programs do not properly display messages with lines over 80 

characters long. If you clear this check box, your message might appear to have extra line breaks to recipients whose mail or 

news reading program can display only 80 characters per line.

It is suggested that you set your limit to about 72 characters. Most mail and news reading programs indent quoted text in replies 

or forwards. Setting the limit to 72 allows the message to be quoted several times without causing extra line breaks.



Specifies whether Outlook Express should immediately forward to your mail server any messages you send. If you clear this 

check box, messages you send are placed in your Outbox and are not sent until you click the Send/Recv button on the toolbar.



Lists the available bit and binary formats for encoding your message.



Shows how your text appears in outgoing messages. Recipients whose servers or e-mail programs do not support text 

formatting see the text displayed as plain text.



Shows how text appears in messages you receive as unformatted text. 



Shows how text appears in the original text included in your reply. Recipients whose servers or e-mail programs do not support 

text formatting see the text displayed as plain text.



Changes the font characteristics, such as font, font style, size, and color. 



Specifies whether to show suggested spellings for misspelled words found during a spelling check. If you clear this check box, 

Outlook Express displays misspelled words but it does not suggest correct spellings. However, you can still type the correct 

spelling in the box.



Specifies that Outlook Express should check the spelling in messages you send and give you a chance to change, ignore, or 

correct any misspelled words.



Specifies that Outlook Express should check the spelling in the background so you can continue typing.



Specifies whether to ignore words in uppercase letters. This is useful when the text you are sending contains computer-

programming code, which is often in uppercase letters and uses character combinations that do not form identifiable words. If 

you clear this check box, Outlook Express checks words in uppercase for misspelling. 



Specifies whether to ignore words that contain numbers. If you clear this check box, Outlook Express checks words that contain 

numbers for misspelling.



Specifies whether to ignore misspelled words in the original text included in a reply or forward. If you clear this check box, 

Outlook Express checks the original text, in addition to your own, for misspelled words.



Specifies that no signature should be added to your messages.



Specifies that a text file should be used as a signature in your outgoing messages.



Specifies that you want to insert the contents of a text file as part of your signature. You can type the path and name of the file 

you want to use, or you can click Browse to locate the file.



Specifies whether to add your signature to all outgoing messages. If you clear this check box, outgoing messages do not contain 

your signature unless you add it to an individual message.



Specifies whether to add your signature to all outgoing messages except replies or forwards. If you clear this check box, 

outgoing messages do not contain your signature.



Displays a possible error, such as a misspelled word, a duplicate word, or incorrect capitalization. The word is highlighted in the 

message, so you can see it in the context in which it is used.



Proposes a replacement for the word displayed in the Not in dictionary box.

To replace the word displayed in the Not in dictionary box, you can:

· Accept the word listed in the Change to box by clicking Change.

· Type the correct word in the Change to box, and then click Change. 

· Double-click a word in the Suggestions list.

To delete the word from the document, delete the text in the Change to box, and then click Delete, or, to delete all instances of 

the word in the document, click Delete All.



Lists suggested replacement words from your dictionary when you click Suggest or if you have selected the Always suggest 

check box on the Spelling tab. 



Specifies the rules that Outlook Express uses to check spelling.



Reverses the most recent actions made during the spelling check. You can undo several changes by clicking Undo Last several 

times.



Leaves the word in the Not in dictionary text box unchanged.



Changes the word in the Not in dictionary text box to the word in the Change to text box.

If the Change to text box is empty, the button name changes to Delete. Click Delete to delete the selected word.



Adds the word in the Not in dictionary text box to the Outlook Express dictionary.



Closes this dialog box.



Leaves all instances of the word in the Not in dictionary text box unchanged in your message.



Changes all instances in this message of the word in the Not in dictionary text box to the word in the Change to box.



Displays a list of proposed alternatives for a misspelled word.



Specifies that Outlook Express should download messages from all newsgroups that you subscribe to, from all servers that 

contain newsgroups that you subscribe to. 



Specifies that Outlook Express should download messages from only the subscribed newsgroups that you select, from all 

servers.

You can select individual subscribed newsgroups on one or more servers, or all subscribed newsgroups on individual servers.



Lists your newsgroup servers and the subscribed newsgroups on them, and provides a place to select servers or newsgroups to 

download.

To display the subscribed newsgroups on a server, click the plus sign (+) next to the server. 



Specifies that Outlook Express should download only the headers for the newsgroups you select to download. You can later view 

those headers and select which messages you want to download.



Specifies that Outlook Express should download the headers and message bodies for the newsgroups you select to download.



Specifies whether to download any new messages that have been posted longer ago    than the number of days you specify. If 

you clear this check box, all new messages will be downloaded.



Downloads messages now.




